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 1  Introducción 

En la antigüedad se creía en la inmutabilidad del 

firmamento. Con el término de estrellas fijas se 

designaba a los objetos que, aparentemente, no 

cambiaban de posición en la esfera celeste. Así, 

se podían distinguir de otros cuerpos como la 

Luna y los planetas, que sí seguían un 

movimiento y evolución en el cielo. En este caso 

práctico veremos que las estrellas fijas no están 

realmente tan fijas. 

Existen diferentes razones para explicar el 

cambio de posición de una estrella en el cielo. 

Por un lado, hay cambios aparentes debido al 

movimiento de la Tierra alrededor del Sol, lo que 

se denomina paralaje astronómica y a la 

velocidad finita de la luz (aberración). 

Por aparente queremos decir que la estrella 

parece que se mueve, pero en realidad no es así. 

En el caso de la paralaje, por ejemplo, es la 

Tierra la que realmente se mueve. Y, por otro 

lado, existen también variaciones reales en la 

posición de las estrellas debido a su movimiento 

propio. 

 2  Movimiento propio 

Entendemos por movimiento propio la variación 

real de la posición de una estrella en el cielo 

debido al movimiento relativo entre ella y el Sol 

(véase figura 1). 

Es una medida del desplazamiento verdadero de 

la estrella con respecto al Sistema Solar y está 

producido por la rotación de las estrellas 

alrededor del centro de nuestra galaxia. 
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El movimiento propio viene dado por la 

siguiente expresión: 

𝜇2 = 𝜇𝛿
2 + 𝜇𝛼

2 · cos2𝛿    (1) 

   

donde 

𝜇𝛼 = 𝛼1 − 𝛼2    (2a) 

 

𝜇𝛿 = 𝛿1 − 𝛿2      (2b) 

 

indican los desplazamientos angulares en las 

coordenadas de la ascensión recta (α) y la 

declinación (δ), respectivamente. 

Así, el movimiento propio nos indica la distancia 

angular que recorre la estrella en un año y se 

suele medir en segundos de arco por año. 

𝑑𝑖𝑠𝑡𝑎𝑛𝑐𝑖𝑎   𝑎𝑛𝑔𝑢𝑙𝑎𝑟

𝑡𝑖𝑒𝑚𝑝𝑜
=

′′

𝑎ñ𝑜
      (3) 

 3  La estrella de Barnard 

La estrella de Barnard, llamada también como 

V2500 Oph, es la estrella conocida con mayor 

movimiento propio, con 10,358"/año [1] (véase 

figura 2). Se encuentra muy cerca de la Tierra, a 

5,9 años luz. Tan solo el Sol y las tres 

componentes de Alfa Centauri están a una 

distancia menor de la Tierra. Tiene una masa de 

0,15 masas solares [2], y una temperatura 

superficial de 3223 K [2], menos que el Sol que 

tiene 5700 K, y una luminosidad 2500 veces 

inferior a la del Sol [3]. En tamaño, la estrella de 

Barnard es comparable al planeta Júpiter, siendo 

mucho más pequeña el Sol (véase figura 3). A 

este tipo de estrellas se les denomina enanas 

rojas y se sitúan muy por debajo de la posición 

del Sol en el diagrama H-R [4] (véase figura 4). 

 

 

 

Figura 1. Movimiento propio de una estrella. 

Figura 2. Movimiento propio la estrella de 

Barnard. Se muestra la estrella observada 

desde 1991 hasta 2007. Fuente: One-Minute 

Astronomer. 

Figura 3. Tamaño a escala del Sol, la estrella 

de Barnard y Júpiter. 

Figura 4. Diagrama H-R donde se muestran la 

estrella de Barnard y el Sol. 
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 4  Herramienta del Observatorio 
Virtual requerida: Aladin 

Aladin es un potente atlas interactivo del cielo, 

desarrollado y mantenido por el Centro de Datos 

astronómicos de Estrasburgo (CDS), que 

permite al usuario visualizar imágenes de 

cualquier parte del cielo y superponer datos de 

tablas y catálogos de diferentes archivos 

astronómicos. 

Para la instalación, simplemente, se tiene que 

acceder a los enlaces mostrados a continuación 

y descargarlos en el escritorio o la carpeta que se 

vaya a usar en este caso práctico. 

Aladin es una aplicación Java que se puede 

descargar gratuitamente entrando en la siguiente 

página web:  

https://aladin.cds.unistra.fr/ 

Para la realización de esta práctica vamos a 

utilizar la versión Aladin.jar 11.0 que está 

disponible en el siguiente enlace: 

https://aladin.cds.unistra.fr/java/Aladin11.0.jar 

NOTA: se utilizará una versión sin necesidad de 

un entorno de Java en formato de ejecutable 

directamente, pero cualquier otra versión tendrá 

el mismo funcionamiento. 

 5  Desarrollo del caso práctico 

 5.1  Abrir Aladin y cargar la imagen de 
la estrella de Barnard 

Una vez instalado, abrimos Aladin, que estará en 

el directorio en el que se ha descargado 

previamente. Para poder calcular el movimiento 

propio, debemos escoger dos imágenes tomadas 

en épocas diferentes. Para ello, en la pestaña 

superior central de Command escribimos 

Barnard Star (véase figura 5), pulsamos Enter 

y haremos lo siguiente en la ventana principal de 

Aladin (véase figura 6): 

View → Panels → 4 panels (Mayús + F2) 

En la imagen superior izquierda se podrá acercar 

y alejar la vista con la rueda del ratón. 

 

 

La imagen que se carga automáticamente 

corresponde al Digitized Sky Survey 2 (DSS 2 

color, véase figura 7). Este survey, producido 

por el Space Telescope Science Institute 

(STScI), contiene imágenes tomadas por el AAO 

(Australian Astronomical Observatory), el 

Observatorio Palomar y el HST (Hubble Space 

Telescope), que cubren la totalidad del cielo [5]. 

 

Volviendo a la imagen del panel situado en la 

parte superior izquierda, se puede ver que 

aparecen dos puntos, naranja y azul, que 

corresponden a la imagen de la estrella de 

Barnard, tomada en dos momentos diferentes. 

Para reconstruir esta imagen y poder calcular el 

movimiento propio de la estrella entre las dos 

épocas, se procede de la siguiente forma: 

1º/ Abrimos el selector de servidores (véase 

figura 8): 

File → Open server selector… (CTRL + L) 

Figura 5. Ventana principal de Aladin. 

 

Figura 6. Ventana principal de Aladin. 

 

Figura 7. Lista de surveys y visor de Aladin. 

 

https://aladin.cds.unistra.fr/
https://aladin.cds.unistra.fr/java/Aladin11.0.jar
https://aladin.cds.unistra.fr/java/Aladin11.0.jar
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2º/ En la ventana del selector, pulsamos sobre la 

opción DSS (from STScI) de la barra izquierda. 

3º/ Escribimos el nombre de la estrella en la 

pestaña de Target (ICRS, name), seleccionamos 

el Sky Survey de POSS2UKSTU_Red y una 

altura y anchura (Height y Width) de 6 arcmin en 

ambas. 

 

 

 

4º/ Sobre el panel superior derecho, se pulsa clic 

derecho y se bloquea la vista en Locked view. 

5º/ Se pulsa con clic izquierdo en el panel 

inferior izquierdo y se repiten los pasos del 1 al 

4, cambiando el Sky Survey del punto 3 por el 

survey POSS2UKSTU_Blue (véase figura 9). 

Estos dos survey del DSS corresponden al 

Palomar Observatory Sky Survey, una colección 

de placas fotográficas digitalizadas que cubren 

todo el cielo accesible desde el Observatorio de 

Monte Palomar, desde +90 a -27 grados de 

declinación, y en distintas zonas del espectro 

electromagnético, o color. 

 5.2  Generador de Película 

Aladin permite combinar las dos imágenes en 

una película para confirmar si la estrella se ha 

desplazado. Para ello haremos lo siguiente en la 

ventana principal de Aladin: 

Image → Blink/Movie generator… 

 

En la ventana de asociación de imágenes (véase 

figura 10), se seleccionan en las dos primeras 

celdas las dos imágenes de la estrella de Barnard 

tomadas por STScI, y elegimos el delay (o 

retraso) con el que queremos verlas, por 

ejemplo, 1600 milisegundos. A continuación, 

hacemos clic en create para generar la película, 

que se creará en el cuarto panel del visor. 

 

 

Se puede apreciar claramente el movimiento de 

la estrella de Barnard frente al fondo de estrellas 

fijas. Si no se activa la visualización de la 

Figura 8. Ventana del selector de servidores. 

 

Figura 9. Visor de Aladin mostrando las 3 

imágenes. 

 

Figura 10. Ventana asociaciones de imágenes. 
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película, se puede usar el deslizador que aparece 

sobre la imagen de la misma (véase figura 11). 

 

 5.3  Medida de la distancia angular 
entre las dos épocas 

Para medir la distancia que se ha movido la 

estrella de Barnard procederemos de la siguiente 

manera. 

Seleccionamos el icono dist en la opción que 

aparece en la barra de herramientas vertical de la 

derecha del visor de Aladin (véase figura 12). A 

continuación, en la imagen superior izquierda 

haciendo zoom para ver mejor la imagen, 

tenemos que comprobar que las imágenes 

naranja y azul de la estrella corresponden con las 

dos posiciones de las dos imágenes del DSS, 

pulsamos con el clic izquierdo sobre el centro de 

la estrella y volvemos a pulsar en el centro de la 

estrella del otro color. Aparecerá una flecha que 

nos indicará la distancia angular entre ambas 

posiciones, aproximadamente 32 segundos de 

arco (véase figura 13). Además, la medida de 

distancia angular que se ha realizado en la 

primera imagen (superior izquierda) se verá 

también en el resto de las imágenes. 

 

 

 5.4  Cálculo del movimiento propio 

Para calcular el movimiento propio pulsaremos 

con el botón derecho sobre cada una las 

imágenes POSII y pulsamos en la opción 

Properties. 

Así, se abre la ventana de propiedades que 

contiene información sobre las imágenes en la 

que se realizó cada una de las observaciones. 

Habrá que hacerlo para las dos imágenes de la 

estrella de Barnard (véase figura 14). 

 

En las ventanas de propiedades, hacemos clic en 

Get original header para que Aladin nos muestre 

en una ventana nueva la información de las 

imágenes. Ahí se podrá ver, en cada una de las 

imágenes, en la fila de DATE-OBS la fecha de 

observación, de manera que tendremos que para 

la imagen azul la fecha es 1988-05-12 y para la 

imagen roja la fecha es 1991-06-16, en formato 

año/mes/día (véase figura 15). 

Para transformar las fechas a formato decimal, 

se calcula mediante la siguiente expresión: 

𝑎ñ𝑜[𝑑𝑒𝑐𝑖𝑚𝑎𝑙] = 𝑎ñ𝑜 +
𝑚𝑒𝑠 − 1

12
+

𝑑í𝑎 − 1

365
 

Obtenemos así las fechas 1988,36347032 y 

1991,45776256, respectivamente, lo que da una 

Figura 11. Visor de Aladin donde aparece un 

frame de la animación donde se puede 

comprobar que la estrella se mueve entre las 

dos posiciones de las dos imágenes utilizadas. 

Figura 13. Zoom en la imagen de DSS2 color 

donde aparecen las dos imágenes de la estrella 

de Barnard en dos épocas distintas. 

Figura 14. Ventanas de propiedades de los dos 

planos de las imágenes. 

Figura 12. Herramienta de distancia. 
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diferencia de 3,09429224 años. El 1 de la 

expresión anterior, que se resta en los días y los 

meses, está para obtener el año exacto a fecha de 

1 de enero. 

 

Finalmente, para calcular el movimiento propio 

de la estrella de Barnard haremos uso de la 

expresión (3): 

𝜇 =
31,91"

3,09429224 𝑎ñ𝑜𝑠
 

resultando en un movimiento propio de 10,312” 

por año. 

Comparemos, a continuación, este valor con el 

que aparece en la base de datos de SIMBAD. 

Para ello haremos lo siguiente en la ventana 

principal de Aladin: en la pestaña inferior 

izquierda, donde aparece select, escribimos 

simbad. Esto mostrará, en la parte izquierda de 

la ventana de Aladin, una lista de bases de datos. 

Pulsamos sobre la tercera línea en SIMBAD 

Astronomical Database y cargamos la base de 

datos. 

 

En los paneles aparecerán una serie de iconos 

por encima de la estrella. Seleccionamos la 

herramienta de select (véase figura 16) y en el 

primer panel arrastramos con el cursor para 

abarcar los iconos de la parte central de la 

imagen. 

 

Aparecerá en la parte inferior una tabla donde, 

en la columna MAIN_ID, se podrá leer NAME 

Barnard’s star y GJ 699 b (un candidato a 

exoplaneta detectado orbitando la estrella de 

Barnard). Si desplazamos la barra inferior hacia 

la derecha, podemos leer las columnas de PMRA 

y PMDE, y que corresponden a las componentes 

del movimiento propio en ascensión recta y 

declinación, respectivamente. Junto con el dato 

de la declinación, en la columna DEC, y 

haciendo uso de la expresión (1), se puede 

calcular el siguiente valor para el movimiento 

propio de la estrella de Barnard, teniendo en 

cuenta que hay que dividir por 1000 para pasar 

de milisegundos de arco a segundo de arco: 

10393.1415892 mas/año = 10.393”/año 

Vemos como el valor de SIMBAD es muy 

similar al que hemos obtenido con Aladin. 

 5.5  Cálculo de la velocidad de la 
estrella de Barnard 

SIMBAD también proporciona información 

sobre la paralaje de la estrella de Barnard, la cual 

tiene un valor de 546,9759 milisegundos de arco 

[1]. Para poder ver esa información, se debe 

pulsar sobre el nombre de la estrella (en la 

columna MAIN_ID), lo que nos redirigirá a la 

página web de SIMBAD (véase figura 16). 

Conociendo la paralaje podemos calcular 

fácilmente la distancia a la que se encuentra a 

partir de la siguiente expresión: 

𝑑 =
1

0,549"
= 1,82 𝑝á𝑟𝑠𝑒𝑐𝑠 

 

Figura 15. Header del archivo de la imagen 

roja. 

Figura 16. Herramienta de selección. 
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Donde 1 pársec equivale a 3,26 años luz o, lo que 

es lo mismo, a la distancia que recorre la luz en 

3,26 años, igual al valor de distancia de 

30.856.802.500.000 kilómetros. 

Asimismo, debemos transformar el movimiento 

propio de segundos de arco/año a radianes/año a 

partir de la siguiente fórmula: 

1 rad = 206265” 

𝜇 =
10,312"/año

206265"/rad
 = 0,00005013  rad/año 

 

Por tanto, la distancia recorrida por la estrella de 

Barnard en un año viene dada por la siguiente 

expresión: 

𝑅 = 𝑑 · 𝜇 = 0,0000917 pársecs
 

Equivalente a 2830735813 km en un año, o lo 

que es lo mismo, a una velocidad de 89,76 km/s. 

 

 

Para saber más sobre: 

 Diagrama H-R 

 Movimientos propios 

 Paralaje 

 Tipos espectrales  

 

“100 conceptos básicos de Astronomía” 

https://www.sea-

astronomia.es/sites/default/files/100_conceptos

_astr.pdf 

 

Para saber más sobre: 

 Observatorio Virtual: 

https://svo.cab.inta-csic.es/main/index.php 

 

 

 

 

 

NOTA: 

Si hace uso de esta guía, por favor, incluya la 

siguiente frase de agradecimiento en cualquier 

tipo de publicación o presentación: 

"Esta publicación / presentación ha hecho uso de 

las guías educativas de Observatorio Virtual 

originalmente desarrolladas en el marco del 

proyecto EuroVO-AIDA (INFRA-2007-

1.2.1/212104) y actualizadas en el marco del 

proyecto PID2020-112949GB-I00 financiado 

por: MCIN/AEI/10.13039/501100011033/" 
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